Fermilab SharePoint 2010
End-user Training Manual

This training manual is focused on providing information and hands-on examples for end-users at
Fermilab.
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Useful Online Resources

Fermilab Resources:

e Fermilab integration environment: https://intranet-int.fnal.gov/

e Fermilab integration environment “sandbox” for a new site: https://intranet-int.fnal.gov/
sandbox/ i.e. COM

e Fermilab SharePoint Help Site: https://sharepoint.fnal.gov/help/Pages/HelpHome.aspx

e Fermilab SharePoint Help Blog: https://sharepoint.fnal.gov/help/HelpBlog/default.aspx

e Latest version of this End-user manual:
https://sharepoint.fnal.gov/cd/sites/com/SharePointCOM/Training%20content/Fermilab%20Sh
arePoint%202010%20End-user%20Training%20Manual.docx

Online resources from Microsoft:

e Microsoft SharePoint 2010 | For End Users: http://sharepoint.microsoft.com/en-
us/product/benefits/End-User/Pages/default.aspx

e Microsoft “That’s why | use SharePoint” site:
http://sharepoint.microsoft.com/iusesharepoint/landing.aspx

e Microsoft SharePoint 2010 Quick Reference Cards:
http://download.microsoft.com/download/d/4/2/d4290c8a-5563-44a7-96a6-
9fe77eff40b0/qrc _all.pdf
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Additional training opportunities

SharePoint computer-based training for Employees
Fermilab employees can request online, Computer-based SharePoint training through the Fermilab

Service Desk:

1. Login to the Service Desk. From the “Self-Service” area, select “Service Catalog”.

2= Fermilab

K Welcome: Kimberly Myles

Type filter text AAZBE~
Self-Service Al B
{2t Homepage |E
£ Employee Self Service ‘

(3 Service Catalog 4
& Knowledge

2. From the “Desktops and Laptops” area, select “Microsoft E-Learning”

= Desktops and Laptops = Email & Calendaring

B Order Accelerator Division Approved Laptops and Desktops %, Request Email Account

§_ Order a New Laptop/Desktop and Peripherals «, Request Inbox Size Increase

Request a Loaner Laptop @ Request Instant Messaging Client
Request Software 4 Request Help with Outlook
Proprietary Product Request & Request Help with MacMail

E,S Microsoft Home Use Program Request ‘f@ Request a New Listserv Mailing List

£:a Microsoft E-Learning _ge—— [£] MX Record Variance Request

= Something Broken
@ Lederman Science Center Exhibit

= Accounts

@ Comnuting Lisername & Primarv Accounts
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3. A page appears providing more detail on how to register and a link to what courses are
available.

Learning Tree
Learning Tree offers a series of SharePoint classes suitable for all levels of users.

List of SharePoint classes offered by learning tree:

http://www.learningtree.com/training-directory/sharepoint-training-6.htm

Please consult your manager or supervisor to determine if you can attend one of these classes.
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Introduction

SharePoint is an extensible and scalable web-based platform that
supports the collaboration and sharing of information within teams
and throughout the organization. It has a Microsoft Office-like
interface and is user-configurable and adjustable.

You can use it for cross-platform file sharing, web content
management and document management.

One common use of SharePoint is to create sites that are used for
team collaboration. These collaborative sites, also known as team
sites, enable team members to better work with one another.
Teams can use their site to share documents, assign tasks, track
team events on a shared web calendar and much more.

1) Authentication
1.1 Login to SharePoint

Depending on the platform you are using (Mac, PC or Linux) you
can use the following web browsers to access SharePoint:

e Internet Explorer
e Mozilla Firefox

e Google Chrome
e Safari

SharePoint tips

. SilverLight is an application that
optimally enables multimedia,
graphics and animation to run on
SharePoint.

®  You can check to make sure the
SilverLight player is installed on
your system from the following
Microsoft site:

http://www.microsoft.com/getsilverligh
t/Get-Started/Install/Default.aspx

. For PC users: Silverlight is normally
installed by default.

. For Mac users: you may need to
download and install the player
from the Microsoft site above.

Authentication tips

° To avoid compatibility issues, start
SharePoint in a 32- bit browser.

. For more detailed information
regarding supported browsers,
please visit:
http://technet.microsoft.com/en-
us/library/cc263526.aspx
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To Login:

The URL is: https://sharepoint.fnal.gov/

1) From the upper right hand corner of the page, click “Sign In”.

E ™

) v
{F SharePoint

SharsPont eare = ¥ ] 7]

Fermilab SharePoint collaborative site

2) Enter your Services Account username and password and click “Sign
In”.

Login tips

. If you do not have a Services

Account but you have a valid,
active Fermilab ID number, you
can request a Services account in
Service Now:
http://computing.fnal.gov/xms/Se

rvices/Getting_Started/Introductio

n to Computing at Fermilab/Get

ting Started as a Non-

Employee Off-site User

o If you do not have a valid ID
number, please fill out the
following form to request one:
https://computing.fnal.gov/offsite

visitor/offsite _acct request.shtm
|
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2) Working with a Fermilab team site

One of the fundamental kinds of web sites that SharePoint 2010 allows you to create is a team site. A
team site is a SharePoint site that you can use to collaborate with your coworkers. Other types of
SharePoint 2010 web sites are covered in Section 7.

Note: Each organization at Fermilab will be given a SharePoint site collection sandbox (test site). Your
SharePoint trainer will provide the URL during your training session.

2.1 Team site features

All SharePoint team sites have the same features:

Header; The header spans the entire top of the page.

b, Left navigation menu or “Quick Launch bar”: the navigation pane provides quick access
to the site’s document libraries, Lists and discussion boards- any features configured on
this site. You can even add links to content you create, such as documents and web
pages.

c. Page.content: The content displays in the body of the page.

U8 CEPARTME

Fermilab | @ ENERGY

CMS  Grgups » & (7]

Libraries CMS * Home

Site Pages

Shared Documents Welcome to your site!

Calendar Add a new image, change this welcome lext or add new lists fo this page by dlicking the edit button above. You can
dlick on Shared Documents to add files or on the calendar to create new team events. Use the links in the gefting

Tasks started section to share your site and customize its look

Team Discussion Shared Documents

Type Name Modified By

(i Al Site Content

Getting Started
& share this ste

I crange sie theme

|58 set a site icon

[B customize the Quick Launch

Fermi National Accelerator Laboratory | Office of Science / U.S. Department of Energy | Managed by Fermi Research Alliance, LLC | Security, Privacy, Legal

Done € Local intranet | Protected Mode: Off v R10% ~
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All new SharePoint team sites have the following features:

a. Site Actions menu: This menu is used by Site Owners and Administrators to control site settings.
Page up icon: Allows you to view the current page and any pages above it in navigation.
Ribbon tabs: These include tabs for Browse or Page. Browse enables you to view a team site, Page changes the view
to a ribbon view. From the ribbon, you can manage page permissions, settings and library permissions and settings.

d. Search Scope: This dropdown menu features search refiners that help to narrow your search criteria.

e. Search box: This is the field search content is entered into.

f.  User menu: If you click on your Name, a dropdown menu appears with links to your My Site, My Profile, My Settings
and options to Sign in as a different user, Request Access to the site (if you are a visitor) and Logout.

g. Navigation bar: This bar is used to navigate to different sites. Items can be added, moved or renamed by Site Owners
or Administrators.

h. Tag buttons: Click to tag pages or documents that you want to easily track and “like”, Likes and Tags will appear on
your MySite.

i.  Help button: Provides links to Microsoft Help topics.

j. Breadcrumb trail: This navigation displays a set of links at the top of Web pages to show where you are in the site
hierarchy.

k.  Site introduction: This is your team site greeting which provides information to visitors about your site.

I.  Shared Document Web Part: This is a document library that allows Site Owners and contributors to upload and
download content into the library.

m. Site Image: This is an out of the box image that appears for sites by default. Site contributors can change this image or
remove it altogether.

(See image on page 9 for more information)
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2.2 Create a My Site Team Site for production testing purposes

Anyone with a Services Account and password can create a My Site team site sub-site for use as a
production sandbox to test basic SharePoint features covered in training.

NOTE: For more complex testing, please test in the integration environment: https://intranet-

int.fnal.gov/Pages/Default.aspx

To create a My Site team sub-site in integration:
1. In the upper right hand corner of any page click the link for your name.

2. Select "My site" from the dropdown menu.

L Kimberly Myles ~

I My Site
l Open your personal thr‘nf:;:tag»:-.{b

My Profile
I View and manage your profile.

My Settings
&' Update your user information,

regional settings, and alerts.

Sign in as Different User
Login with a different account.

£ Request Access

d Email the site administrator to
request additional permissions.
Sign Out

3 Logout of this site.

3. From the My Site page that appears' top menu, select "My Content"

My Site MyNewsfeed | My Content | MyProfile Test MyLinks Backto SharePoint

4. From the team site page that appears (with your name as title), select "Site Actions" and then "New
Site".5. In the create menu that appears, select the Team Site template. 6. Add a title such as "Kim's
sandbox" and name the URL (which can be the same as the title).

7. Click "Create" to create your new sandbox team site collection.
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Create
Browse From:

Installed Items > . Type 4

Office.com
Filter By:
NI Types 5 %’ 'i
Site
Team Site
All Categories >

Apphication Templ...

Blank & Custom

Collaboration 33_9
4|

Content
Data Blank Meeting
Workspace

Meetings

Search

Tracking

Web Databases .“_ I

Blog

&

Contacts Web
Database

¥

V4

Blank Site

A

Decision Meeting
Workspace

@

Group Work Site

Issues Web
Database

f

Document
Workspace

Social Meeting
Waorkspace

Assets Web
Database

s
Projects Web
Database

Team Site

Type: Site
Categones: Collaboration

8n§ A site for teams to quickly organize,

author, and share information. It
provides a document library, and lists

Basic Meeting for managing announcements, calendar
Workspace items, tasks, and discussions.
Kim's sandbox

% https://sharepoint.f.../<URL name>
. ll(.m's sandbo| J

Multipage Meeting

Workspace Create | | More Options

Contnibutions Web

Document Center
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2.3 Modifying a team site home page

1) Browse to the home page of your team site and Team site tip
then click “Site Actions -> Edit Page”.

Please do not cut and paste content into a wiki
page from any sources outside of SharePoint. This
can cause formatting issues and freeze the page.

dit Page . .
Edit the contents of this page. Instead, cut and paste content into a text editor
| ;

such as Notepad for Windows or TextEdit for Mac

Sync te SharePoint Workspace

£]

S Create a synchronized copy of first and then paste content into SharePoint.
this site on your computer.
- New Page
| Create a page you can
customize.

New Document Library
Create a place to store and
share documents.

o

New Site
Create a site for a team or
project.

©

More Options...
Create other types of pages.
lists, libraries, and sites.

View All Site Content
View all libraries and lists in this
site.

: Edit in SharePoint Designer
t- ﬁ Create or edit lists, pages, and
A vorkflows, or adjust settings.

Site Permissions
@ Give people access to this site.

5 Site Settings
‘:0%5 Access all settings for this site,

L £ Cut = =1 = <> Ry -
l_j_ _%I - U verdana - spt - = 1= iE ZIED Af, ‘y | *
0 copy L =[=

Li Select =
Save & Close Check Out  Paste 2 abr -A Styles  Spelling Text  Markup
. . = Undo . || B Z U sha 3, x A-h EEES = - Layout »  Styles = <3 HTML »

Edit Clipboard Font Paragraph Styles  Spelling  Layout Markup

Libraries
Site Pages

Welcome to your site!

Shared Documents

Add a new image, change this welcome text or add new lists to this

Lists page by clicking the edit button above. You can click on Shared
Documents to add files or on the calendar to create new team events.

Calendar Use the links in the getting started section to share your site and
customize its look

Tasks

Discussions Shared Documents

Team Discussion i i
Type Name Modified Modified By

- There are no items to show in this view of the "Shared Documents” document
A Recycle Bin library. To add a new item, click "New" or "Upload"

2h AN Site Content & Add document

Getting Started
& share this site
I change site theme
[5d] set a site icon

[ customize the Quick Launch

2) With the page in Edit mode, you can place your cursor anywhere inside the rectangular boxes
in the page’s body to edit the content.

Fermilab SharePoint Training Page 13



2.3.1 Changing a page title or text

1. While in edit mode, click on the page and your input will appear wherever your cursor is.

= 1=z s N < @ -
Verdana - Zem - TS EEE W A, L
; 3 18] <4>
; o w.oA. A EFEEER Styles  Spell Text T
iave & Close ChecdkOut  Paste B I U shax X ®. A yies  Speling T arkup
. . - ¥ undo . ¥ - Ll d)) | B - Layout=  Stiless <ZHTML
Edit Clipboard Font Paragraph Styles  Speling  Layout Markup
Libraries
Site Pages

Test Site|

Shared Documents

Lists
Calendar

customize its look.

Tasks

Discussions

Shared Documents

Team Discussion

Modified Modified By

Shared Documents” document

{a) Recycle Bin

2D ANl Site Content

& add document

Getting Started
8B share this site

|

Change site theme
Set 2 site icon

5
[ Customize the Quick Launch

2.3.2 Changing the page layout
1.

Format Text

Click “Text Layout” on the Ribbon and make a selection from the menu options.

H _%l o verdana - et - ZE EEM| A/ ‘& O c‘l} @ .
copy R A [ select=
Savsa:cluse C'li(l(ol.“ Pn_st(- ) Undo B 7 Uashex, x ¥.-A. A E' == s“‘_'“ Spelhng w;:?t- rt:(ek;lf < HTML
Edit clipboard Font paragraph styles  spelling 1 Ona eslumn
Libraries
Site Pages

Test Site

Shared Documents

Add a new image, change this welcome

ts to this [l
Lists page by clicking the edit button above, ¢

Docu ts to add files or on the calendar e % team events,
Calendar Use the | n the getting started section to sh; our site and 2
Tasks customize its look ad

Discussions Shared Documents

Team Discussion

E
=
=

Type Name Modified Modified By

There are no items to sh
brary. To add & new i

f the "Shared Documents” document

A Recycle Bin

=

2 An site Content & add documant

[l

| Getting Started
$ Share this site
I change site theme

lad| set a site

on

>
% Customize the Quick Launch

One column with sidebar

| Two columns

Twe eolumns with header

Two columns with header and footer

Three columns

| Three columns with header

Three columns with header and footer
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2.3.3 Adding a page image
To remove a page image:

1. Click on the image you want to change and delete it.

SharePoint COM project site

m e

To add a page image:

1. In edit mode, place your cursor in the area of the page
where you want the image to appear.
2. Click on the Insert tab and select the “Picture” icon.

esomepage. i COM project * Home

PowsdFointa SharePoint COM project site
rep
:': a‘;’ The lcus of e SharsPoint COM Brodt Inchuces
- vilp s developmant
+ Developmantof elp Tools” such 83 FACS. user pukdes, quick puides
m © Aa3istance wih e st et and 4nd oe Vg
+ S aP o Erariont B €S aNER 03 o

3. Inthe “Select Picture” dialog box that appears, browse to
find the picture you want to add and click “OK".

& Choote File 10 Upload =
() 5 v Ubiwies » Pictures + Public ictes » Sample Pictres = - s
L

Organze v New folder N |
¥ Favortes 5 Pictureslibrary . .
i o P

i Becer Places
M Desitop

W Liraries
% Documents
o Music
= Pictures
B videes

g e——

Image tip

You can add organization charts,
diagrams and other images you create in
PowerPoint to a SharePoint team site by
saving them locally as .jpegs and then
importing them as a “picture”.

v e —
SharePoint COM project LFermilab | (3 ExeRgy

rrer—— — ]

4. Inthe Site Assets dialog box that appears, you can add a title for your image.

Fermilab SharePoint Training
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5. Click “Save”.

Site Assets - Penguins.ipg

B8 B.. X

Save Cancel Paste Delete
Item

Commit Clipboard Adtions

@ The docaument was uploaded successfuly. Uise this form to update the properties of the document.

Name * Penguins kg

Title

6. Your image will appear on the page. You can re-size it by clicking on it.
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2.3.4 Uploading documents

SharePoint 2010 uses a special kind of container — a Document Library — for storing files. Your team site
has a common default Document Library called “Shared Documents” where you can put documents you
want to share with others. Find out more about Document Libraries in Section 4.

1) Click “Shared Documents” in the left navigation menu.

Documents
Shared Documents
Site Pages

Drop Off Library

Lists
Calendar

Tasks

Discussions

Teamn Discussion

Sites

People and Groups

2] All Site Content

2) Click “Upload Document” on the “Document” tab.

Library Tools
Site Actions ~ @ Browse Documents
5 ’} j Check Out
L — heck In
New Upload New Edit

Document~ Document~ Folder Document

lew Op

3) Click “Browse” and select a file to upload.

4) Click “Ok”.

5) Fill out the “Name” and “Title” field respectively.
6) Click “Save”.

2.3.5 Adding calendar items
SharePoint 2010’s team sites provide you with a default calendar for tracking your team events. This
calendar can be connected to and viewed in Outlook.

1) Click “Calendar” in the left navigation pane.
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Documents
Shared Documents
Site Pages

Drop Off Library
Lists
Calendar

Tasks

Discussions

Team Discussion

Sites
People and Groups

2] Al Site Content

2) Click the “Events” tab and then click “New Event”.

Calendar Tools

Ste Actions ~ Browse Events [ Calendar

3) Type the information for your event.

4) Click “Save”.
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3) Site Navigation

3.1 Page Up button

You can navigate to upper-level sites by clicking the “Navigate

$
Up” button from the navigation bar.

Site AgiaRiery B2 E TS roe
This page location is:

. i
_E Trair L Office of The CIO

L communications

Trainin
< L Training
Libraries L Home
Site Pages WNnTalrAama tna e

This feature shows you where you are at within a site. You can
click on a site or sub site name to navigation to that site.

3.2 Search box

Search tips

. The only search items that will appear after
you've conducted a search are the items
you have permission to view.

. On your site, the search scope will default
to your site collection and search only your
site content. You can search across sites by
choosing “All sites” from the dropdown
menu.

. It takes a half hour for search to pick up
new results, such as a newly added
document or list.

From the top of any page in SharePoint, you can access a search box. In front of the search box, there is
a search scope drop-down list. You can use this list to narrow or “refine” your search by, say, a person or

site.

Search cd-sites-com j p
This Site: Communication

If you receive far more search results than you were expecting, you can use search scope refiners to drill

down into the results to find exactly what you are looking for.

1) Select the search scope you want to use from the drop down list.

2) Type your search term and click the magnifying glass icon.

All Sites j safety P

3) Click the refiner you want to use, e.g. Webpage.
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All Sites | Paople

Preferences
| safety » Advanced

Result Type
Any Result Type

——) Webpage
Adobe PDF
Word

PowerPoint

Site
Any Site

sharepoint.fnal.gov

Author

Any Author

Jamas H Niahoff
John E Anderson Jr
Thomas Page
Heather Kumlin X8...

show more v

Modified Date

s Madifiad Pake
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4)  Working with Document Libraries
A Document Library is a special kind of List (find out more about Lists in Section 6). Document Libraries
allow you to manage files such as documents, spreadsheets, and presentations.

A SharePoint site can contain many Document Libraries, and each Document Library can contain a

hierarchy of folders and files.

4.1 Upload a file to a Document Library
1) Select the “Documents” tab under “Library Tools” on the Ribbon.

2) Click “Upload Document”.

Library Tools

e Actions ~

)T |

New Upload New Edit -
Jocument v Document~| Folder Document Discard Check Out

A Upload Document
- Upload a document from your computer to

Pictures j . . ! :

this library

Cookie Ca . Upload Multiple Documents "
j nicatic

Upload multiple documents from your

computer to this ibrary

Talk Pictur

[P N S R, - LAN AR SNT

3) Click “Browse” and in the “Choose File” dialog box, select a file to upload.
4) Click “OK”.

4.2 Upload multiple files to a Document Library

NOTE: This procedure is for PC users only.

To copy multiple documents (or folders) and move them to another document library:

1. From the Library Tools menu, select “Library”.

Library Tools

Site Actions ~ i [CEONER Documents Library

gE Training » Management Documents * All Documents

Training
Libraries 5] Type Name

Site Pages IZ.:I_] R
Management Eelitiigd .
Documnents @_] Test document 2
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2. Select “Open with Explorer”.

Library Toals

Library

O B

Standard| Datasheet  Mew
View | View Row

Is -
Create
Retresh Data View

View Format Datasheet

[ Modity View . Current View:

fll Create Column Al Documents =

3 Navigate Up « Cument Page
Manage Views

0| Connect to Outiook n j % .; F
(& export to Excel 74 CA = 2 <9

= Formweb Edit  New Quick Library  Library  Workllow
[Egg Open with Explorer Parts ~  Library Step Settings Permissions Settings »

Connedt & Expart Customize Library Settings

3. Hold down your CTRL key and select all of the documents you want to copy, then right click and

choose the “Copy” option.

CJ\J |}, ® https://sharepointfnal.gov » cd » sites b com b SharePointCOM » Training content b
File Edit View Tools Help
Organize » S5 Open  Bum  Newfolder
Eias Name ate modified
B Desktop Archive 3 PM
& Downloads Change Management s, 5 PM
2 Recent Places &) Best Practicesforl = Convert to Adobe PDF
] Fermilab SharePoi| % Combine supported files in Acrobat...
4 Libraries ) Fermilab SharePoi SeanTorVirioes
-\' Documents ] Training topicsds; @ snagit
@ Music Copy as path
| Pictures
H videos Send to L
Cut
1% Computer Copy
& Local Disk (C:)
Create shortcut
G Network Delete
Rename
Properties

4. Navigate to the document library you want to copy these documents to and from the Library
Tools menu, select “Library” and “Open with Explorer”.

5. In “Explorer view”, right click and select “paste” to paste the documents into the new document
library.
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5) Working with documents

SharePoint 2010 provides two methods for working with documents:

» Each document has an “Edit” menu that you can use to take some action on that document,
such as checking it out for editing.

» The Ribbon also displays a set of actions that can be taken on individual documents or a
group of selected documents.

5.1 Using the Edit menu

You see the Edit menu when you hover your mouse over the “Name” of your document. With the “Edit”
menu, you can view and edit properties.

[T Type Name M

.EJ Communications and Qutreach Change Risk Classification Guidance v 9/

View Properties
% Add document

.1) Edit Properties

;B_] Edit in Microsoft Word
fq Check out

:J Version History

Compliance Details
@ Workflows
Add to My Links
Alert Me
Send To 4

Manage Permissions

e

Delete

5.2 Editing a document’s properties
The easiest way to edit a document’s properties is to use the Ribbon:

1) Select the document in the Document Library.
2) Click “Edit Properties” on the “Documents” tab of the Ribbon.

Library Teols

. Lhycreckon :
o _/}' Y st =

£ Edit
der Document

‘,ﬂ Version History

$ Document Permissions

WV Type Name

72 @] Communications and Outreach Change Risk Classificatio

3) Make the changes and click “Save”.
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5.3 Checking documents in and out
Checking out a file prevents other users from editing the file while you are working on it. New edits you
make do not show until you check the file back in.

To check out a document:

1) Inyour Document Library, select the check box next to the document you want to check

out.
2) Click “Check Out” on the “Documents” tab of the Ribbon.

Library Tools
Stte Actions ~ Browse Documents Library

j aj i _‘}‘ _&,cr:a:k i.st ; \ _Z 3 Version History ) _é % g ::a;:

C # @ Document Permissions
View Edit E-maila  Alert Download a

New Upload New Edit
Document~ Document~ Folder Document Disc eck Out  Properties Properties x Delete Document Link Me » Copy GoTo S
New Open & Check Out Manage Share & Ti G
Pictures W Type Name
Cookie Caucus
N E_] Communications and Outreach Change Risk Classification Guidance

Talk Pictures

Lobby display % Add document
3) Click “OK”".
To check in a document:

1) Click the check box next to the document that you want to check in.
2) Click “Check In” on the “Documents” tab of the Ribbon.
3) Inthe Check in dialog box, do any of the following:
o Select “Yes” or “No” to keep the file checked out or not.
e Enter any comments to include in the document’s revision history.
4) Click “OK”.

5.4 Sending a link to a document by e-mail

To share your documents with others, they need to know where to find the document. You can do this
by sending them a link directly to the document itself.

To email a link to a document:

1) Inyour Document Library, select the check box next to the document you want to email.
2) Click “E-mail a Link” on the “Documents” tab of the Ribbon.
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Library Tools

Site Actions .ﬁ Browse Documents m

? ' 3 [y Check Out = [= 3 Version History N \ 5 % )Send To
<l F’ # E f é %
Check In Bt L .@ Document Permissions - % Manage
New Upload New Edit Vi Edit E-maila Alert Download a
Document » Document- Folder Document eck Out  Properties Properties )( Delete Document Link Me ~ Copy GoTo S
ew Ope Manage Share & Track Copies
Pictures

Cookie Caucus

Communications and Outreach Change Risk Classification Guidance
Talk Pictures

Lobby display % Add document

Your default e-mail application will open a new message with a link to the document. You
can choose who to send the link to and send the message as you would any other e-mail.

To email more than one link to more than one document:

1) Right click on the name of the first document you want to copy a link for.
2) Inthe drop down menu that appears, select “Copy shortcut”.

I
Open
Open in New Tab
Open in New Window
Save Target As...
Print Target

Copy Shortcut

3) Paste the link in an email and repeat these steps for each link you want to send.
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5.5 Recover deleted documents

When you delete a document from a Document Library, it isn’t gone
forever. The document just moves to a holding place in your site — the
Recycle Bin.

To restore a document from the Recycle Bin to its original location:

1) Click the Recycle Bin link in the left navigation pane.

Documents
Sharad Documents
COM Documents
Drop Off Library

Status Reports

Lists
Com Calendar

Discussions

COM Team Discussion

Sites
People and Groups

Al Recycle Bin

) Al Site Content
2) Place a check mark next to any files you wish to restore.
3) Click the “Restore Selection” link.

5.6 Versioning

Versioning enables you to select and view previous versions of a document.

To view version history for a document:

1) Select the document you want work with.
2) On the ribbon under Library tools, select the “Documents” tab.
3) Click “Version History”.

SharePoint >..> Office of The CIO > Communications
Library Tools

ite Actions ~ B¥  Browse Documents

j _aj _bCheck Out = =
> E: E
L i3 Check In = ’ $ Document Permissions

New pload New Edit View Edit
Document» Document. Folder Document o, Discard Check Out ~ Properties Properties X Delete Document

MNew Open & Check Out Manage

4) Inthe “Version History” pop up window that appears, click a

Recycle bin tip

. Items that were deleted more
than 30 day(s) ago will be
automatically emptied.

. Contact the Service Desk if
you want to restore any item
after 30 days.

Versioning tips

° Before you can use this feature,
versioning must be enabled by
your Site Administrator for the
document library (or list) that
you want to work with.

° You can restore a previous
version of your document if you
are not happy with changes
made- if versioning is enabled.

. There are two types of versions:
draft versions or published
versions.

“modified date” link to view a version of the document modified on that date.
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Version History ]

5.7 Create alerts
Alerts are a great way to keep track of the changes your teammates make to documents.

To create an alert to a Document Library:

1) Select the Document Library where you want to create an alert.
2) Select the “Library” tab on the Ribbon.

3) Click “Alert Me > Set alert on this library”.

4) From the “Version History”

nications

% Modify View View:
[ Meodify View - Cument View:

- 1l creste Coumn &1 Documents
Standard| Datasheet ) Create
View View Row 1 3 View

Cutrent Page )

N 43 St aler on this library

figw Format

Pictures [ Type Name (3 Minage My Alens

Cookie Caucus

ca Change Management

Talk Pictures
y FermiDash home page requirements project

Lobby display -

Ca Fermitools Project Documents
Docssent= [ ] CC Tour Guide Manual
Shared Documents Ga News Center requirements project
COM Documents ] ORNL ference posters
Deop Oy [ e and Application Usage Raperting
Status Reports

us e 0SG.org Migration

3 9 Mig
How to documentation

=] Standard Service Communications Email Template
Lists -
COM Calandar 4 Add document

5) Fill out the form and click “OK”.
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6) Working with Lists
SharePoint 2010 provides many kinds of Lists that you can use to track information. A List is similar to an
Excel spreadsheet or a table in a database.

In a List, data is gathered in rows, and each row is known as a List Item. A List can have multiple
columns. A List Item is a row with data in those columns.

For example, a List of Fermilab contacts may have the following columns:

e First Name

e lastname

e Fermilab ID
e QOrganization
e Email

e Phone

SharePoint provides three basic kinds of Lists:

» Communication Lists are used to track announcements, contacts, and discussion boards.

> Tracking Lists are used to track information such as links, calendars, tasks, issues, and
surveys.

» Custom Lists provide a starting template that you can build on to create a List with the exact
columns you need.
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6.1 Use the Ribbon to manage Lists
All SharePoint Lists display the Ribbon at the top of the List. You can use the Ribbon to access the
common tasks used for working with Lists.

The menu commands you see in the Ribbon depend on the kind of List you are viewing. Usually the
Ribbon displays List commands in one of two tabs:

> Items: displays all the commands you need for working with items.

Site Actions Browse

> List: displays commands for managing and customizing the entire List, such as creating views
and exporting the List to Excel.

[ Modify View » Cument View

0| B

) 1] Creste Column 20 Inems -
Standard Datasheet Craste
View | Ve View [ n Curent Page

6.2 Create a column
1) Select the List you want to work with.

2) Click the “List” tab on the Ribbon.

Modify View + Cument View Crasts Visio Diagram == [E3 Form Wab Past -
] = @ SI I J | Create Visic Diagra I 52 Form wie Pans
J| D D' ol coss coumn s =1 g LES TP IR /- T @
Standard| Datasheet Create E-mail a Alert RSS Sync to SharePoint Co 3 = List List Workfiow
View Vi Vigw | Ma ¢ Curent Page Link  Mex Feed Workspace o Open Schedule 5 Semngs Permissans Semngs -

!T‘) B . J [ Modify View ~ Cument View: ) @ S ] - 7] €reste Diagram lr. [ Form Webs Pars »
B . . _,; = W -ﬁi
i E s = _fl Creae Comwmn AN Tems V (B open wan access
Standard| Datashest  Mew Create E-mail 3 RSS  Sync to SharePoint Co 3 Customize
View View o ~ Vi % N Currant Page Link Feed Workspace o Open Schadule Fom

4) Enter a name for the column.
5) Select the type of information you want to store in the column.

6) Click “OK”.
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6.3 Create a List View

Views provide a flexible way to create custom display forms for users interacting with list data. Views
provide the ability for you to control which fields are displayed; the order in which fields appear in the
list; and advanced multicolumn sorts and multicolumn filtering.

To create a List view:

1) Select the List in which you are interested.

2) Click “Create View” on the “List” tab.

C @ Twe Title Assigned To Status Priority Due Date % Complete  Predeces:

3) Click “Standard View”.

Choose a view format

Start from an existing view

4) Enter a view name. The name must be unique to the list.
5) In the “Audience” section, select one of the available options:

e “Create a Personal View” creates a view that is only displayed for you.
e “Create a Public View” creates a view that other users can select and use.

6) In the “Columns” section, do any of the following:

e  Click the check box under the Display column to show or hide a column in the view.
e Change the order in which columns are displayed in the view by selecting a position
value from the drop-down list under “Position from Left”.

7) Click “OK” to save the view.
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7) Working with web pages

Your team site is a collection of web pages. Wiki pages are used
for displaying your content:

Wikis derive their name from the Hawaiian word for “quick”. The
Wiki concept is designed to be quick and easy. Use Wiki pages
when you have predominantly rich content; for example, text,
tables, links, and images.

You can insert Web Parts, or use no Web Parts at all.

7.1 Creating a new Wiki page
1) Click “Site Actions -> New Page”.

=  EditPage
? Edit the contents of this page.

| Syneto SharePoint Workspace
S Creste a synchronized copy of
L—2 this site on your computer.

= New Page
Craate a page you can

customize

New Document Library
4 Create a place to store and
) share documents,

New Site

Create a site for a team or
@ project.

More Options...
Create other types of pages,
lists, libraries, and sites.

antant
es Bnd lists in this

Edit in SharePcint Dasignar

workflows, or adjust
Site Permissions

Give people access to this site.

Site Settings
Accass all sattings for this site

“eBEE P

2) Type the name for your page and click the “Create” button.

Wiki tip

A wiki is a website whose users can add,
modify or delete its content via a web
browser using a simplified markup language
or a rich text editor. A wiki is the simplest
online database that could possibly work...

-Wikipedia
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Note: You can change the page’s layout by clicking “Text Layout” on the “Format Text” tab.

- ¥ W Page
5 om cm 53] | . @
I :i _@ i ¢ Verdana ) i & ] A, ‘gf il a
Cop g ; < Iy seecre

Save kCiome CheckOwt  Pame - W, A A Syl Spelind | Tem | Markup
" * = . BT U oske x, X A-% EsaE - Loty Soase <3 HTMLS

Cipboard Font Paragraph PR Speling

] One column

Documents

sion Statement
Shared Documents - ..

-1 One column with sidebar
Sita Pages \J

Drop Off Library Two columns

Lists Untitled 51 Two cobumns with header
Calendar o

Tasks [iE] T cobemns with hesder and foster
Discussions Three columns

Team Discussion

{5551 Thiee columns with header
sites (o

People and Groups Thies columns with header and footer

7.2 Finding and linking other Wiki Pages
1) Go into the Edit mode in a Wiki page by clicking the Edit button.

Site Actions

2 Communications » Home

e

Communications Search Center SuperComputing * Seactor Newsletter SharePoint COM project ™
Pictures

Cocokie Caucus Mission Statement

Talk Pictures

Lobby display The Computing Communications team provides support for the communications activities of th

The mission includes: librarianship of the CS document repository, the internal CS newsletter "Cc
display. coordination of the Fermilab participation in the Super Computing Conference exhibit an

Documents
The group works with sector management on th
communications as embadded members of acti

finition and execution of a Communications
or projects within the sector

Shared Documents

3) Click “View All Pages” under the Page tab to see other pages in the same Wiki page library.

Ste Actions v i

= ‘ _\} Page History o - ﬁ] Make Homepage . @ C_ﬂ
-Z ﬁ $ Page Permissions ‘—\I - _@ =
. name

&3, Incoming Links
Edit  Check Out E-maila Alen Preview Library Library View All
- -

X Delete Page Link Me » ‘_'] Draft Check Settings Permingi@®®) Pages

Edit Manage Share & Track Page Actions Page Library

4) You can link to another page in the same wiki library by enclosing the name of the page in double
brackets in the rich content area. For example, type [[Team Events Page]] to create a link to the
Team Events page.
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8)

8.1

Working with Web Parts

Insert a web part
1) Click “Site Actions -> Edit Page”.

Edit Page
%V Edit the contents of this page.

’I Sync to SharePoint Workspace
Create a synchronized copy of
this site on your computer.

—
- New Page
Create a page you can
customize.

New Document Library
% Create a place to store and
Ll share documents.

New Site

Create a site for a team or
0 project.

More Options...

Create other types of pages,

lists, libraries, and sites.

Manage Content and Structure
g,‘ Reorganize content and

structure in this site collection.
= View All Site Content

‘} View all libraries and lists in this
site

Edit in SharePoint Designer
Create or edit lists, pages, and
workflovs, or adjust settings.

Site Permissions
Q Give people access to this site

e Site Settings
(:_as‘) Access all settings for this site.

2) Ina web part page, click in a zone. In a Wiki content page, click in a rich content zone.

3) Toinsert a web part, click the web part button on the Insert tab.
Editing Tools

SteActions ~ B PP Browse  Page
= H &G N By [T (i

Table Picture Video and Link Upload Web | Existing New

- - Audio - File Content ~ Part List List
Tables Media Links Content Web Parts

jjg:ﬂ gﬂ@j ;

veo B New

Tabke  Piowre Videoand  Link  Upioad w
- . Aot - Fig LT

Tables Media Veb Parts
Categories Web Parts About the Web Part
[ Lists and Libearies 2] ) COM Announcemaents

=T e

(=]

=]

=}

(=

=]

=}

add wab Part taf Rich Contant =

Add Cancal
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8.2 Configure a web part
1) Click “Site Actions -> Edit Page”.

Edit Page
Edit the contents of this page.

.

Sync to SharePoint Workspace
Create a synchronized copy of
this site on your computer.

wy
45

New Page
Create a page you can
customize.

New Document Library

Create a place to store and
share documents.

5 |

New Site
Create a site for a team or

0 project.

More Options...
Create other types of pages,
lists, libraries, and sites,

Manage Content and Structure
% Reorganize content and
structure in this site collection.
= View All Site Content
‘}. View all libraries and lists in this
site.

Edit in SharePoint Designer
Create or edit lists, pages, and
workflows, or adjust settings.

Site Parmissions
@ Give people access to this site.

Site Settings
Access all sattings for this site.

ra)

o)

2) Select the drop down control to the right of the Web Part title and click “Edit Web Part”.

COM Links
@ Computing Sector Home Page Minimize
@ CS Document Database x Delete

@ Supercomputing Conference =
. 0 Edit Web Part
@ Fermitools =

8 Computing Sector Newsletter
9 Add new link

3) Modify the configurations as you like.
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8.3 Remove a web part from a page
1) Click “Site Actions -> Edit Page”.
== Edit Page —
ﬁEd\t the contents of this page.

Sync to SharePoint Workspace
Create a synchronized copy of
this site on your computer.

Create a page you can
customize.

New Document Library
Create a place to store and
share documents.

53
ﬂ New Page
8]

New Site
Create a site for a team or

0 project.

More Options...
Create other types of pages,
lists, libraries, and sites,

Manage Content and Structure
ﬂ% Reorganize content and
structure in this site collection.

=h View All Site Content
j View all libraries and lists in this
site.

< Edit in SharePoint Designer
r% Create or edit lists, pages, and
Ca workflows, or adjust settings.

Site Parmissions
= Give people access to this site.

5 Site Settings
{:ﬁ) Access all sattings for this site.

2) Select the drop down control to the right of the Web Part title and click “Delete”.

COM Links

@ Computing Sector Home Page Minimize

¥ CS Document Database — Delete

@ Supercomputing Conference = .
s - [ Edit web Part

8 Computing Sector Newsletter

4 Add new link
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